POIConverter Version 3.14, 12 August 2005

Introduction

 POIConverter will convertInstructions Points of Interest (waypoints) stored in the following formats to any of the other formats in the list. In addition route and track data conversions are available for the TomTom, Maptech, Garmin, GPS eXchange, Excel and OziExplorer formats

· TomTom overlaysTomtomNavigatorOverlays (*.ov2, *.ovr)

· TomTom ASCIITomtomAsciiData files (*.asc)

· TomTom Navigator 3 ItineraryTomtomNavigator3ItineraryFiles files (*.itn)

· Maptech MarksMaptechMarks files (*.mxf), RouteMaptechRouteFiles files (*.rxf), TrackMaptechTrackFiles files (*.txf)

· Memory-Map CSV files (*.csv)

· Garmin PCX5 WaypointGarminWaypoints files (*.wpt), RouteGarminRouteFiles files (*.rte), TrackMicrosoftAutorouteMaps files (*.trk)

· GPS eXchangeGpsExchangeFiles files (*.gpx)

· AutoRoute Pushpins AutoroutePushpins(*.csv)

· ExcelMicrosoftExcelFiles files (*.xls)

· OziExplorer Waypoint files (*.wpt), Route files (*.rte), Track files (*.plt)

Also the following formats can be read

· TomTom Navigator Log files (*.pgl)

· MapSourceMapsourceFiles waypoint, route and track data (*.txt) using decimal Lat/Long coordinates

· Microsoft Maps files (*.axe, *.est, *.ptm) PushPin and route data

· Pocket StreetsMicrosoftPocketStreets PushPin files (*.psp)

and the following formats can be written

· AutoRoute PushPinsAutoroutePushpins with Continental numbers (*.tab)

· Destinator 3 waypoint files (*.csv)

· Mapopolis waypoint files (*.mlp)

The waypoint symbolsSymbols are mapped to the set of 16 used by MapSource.

The external data entries are read into an internal data structureInternalDataStructure that is used to populate the records of the selected output format.
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Instructions

 Firstly, use the Open button [image: image1.bmp] to select an input file of the required type.

Secondly use the buttons (or OptionsOptions menu) to configure the conversion.

Use the buttons [image: image2.bmp] [image: image3.bmp] [image: image4.bmp] [image: image5.bmp] [image: image6.bmp]to set default parameters for the Garmin ,Maptech, OziExplorer, TomTom and GPS eXchange conversions. 

Use the Lat/Long or OSGB buttons, [image: image7.bmp] [image: image8.bmp], to select the coordinate output format for TomTom ASCII files or Excel spreadsheets. 

Use the Point, Route and Track buttons [image: image9.bmp] [image: image10.bmp] [image: image11.bmp] to specify the type of data being read or output. These buttons can be used to change the type of data to be output. For example, a sequence of points can be changed to a route by reading the data in as Points, then prior to output, selecting the Route button and saving to a file.

Use the Append button [image: image12.bmp] to read POI data from another file if you wish to join multiple sets. 

Finally, use the Save button [image: image13.bmp] to specify the format and name of the output file.

Debugging output will be written to the file debug.txt in the folder that contains the file POIConverter.exe if a file named Debug.yes exists in that folder. The file Debug.no can be renamed or a new file created.

Options

 The Maptech menu option and button, [image: image14.bmp], can be used to define defaults for the short name and symbol to be used for the marks created when converting from another format. The output record number will be appended to the short name prefix to create the short form name. For example the prefix PG9-W could be used as a prefix to identify the walks in the OS Pathfinder Guide number 9. The generated short names would then be PG9-W1, PG9-W2 etc.

The Garmin menu option and button, [image: image15.bmp], can be used to define defaults for waypoint identifier, altitude, proximity and symbol number. The Date and Time fields will be set to those values current when the option dialog box is opened. The Date and Time fields will be left blank for tracks that have been converted from formats that do not support these entries. Ticking the Replace existing waypoint IDNT box will force new waypoint names to be output. These names will be created using the IDNT prefix followed by a unique number.

The OziExplorer menu option and button, [image: image16.bmp], can be used to define defaults for altitude, proximity and symbol number. The Date and Time fields will be set to those values current when the option dialog box is opened.

The TomTom menu option and button, [image: image17.bmp], can be used to select the internal field, ie Description, Comment or Name, which is to be used when creating names for POI, and the prefix to be used when forming a name for a POI that would otherwise be blank. The text used to form the POI names can be truncated in 3 ways; At 32 characters, At 10 characters but made unique by modifying the last few characters, At first comma in the text but with a maximum of 32 characters. The full length of 128 characters may not be visible in map view when using TomTom Navigator.

The GPS eXchange menu option and button,[image: image18.bmp] , can be used to change the style of the waypoint name written to the output file. Ticking the Use uppercase letters only box will convert any letter in the name to uppercase but will skip any other characters, including spaces. Ticking the Make names unique box will make the waypoint name unique by overwriting the trailing characters of the name with a number denoting the multiplicity of the name. The maximum number of characters in the name will be determined by the setting of the radio buttons Maximum of 10 characters and Unlimited (maximum of 128).

The Lat/Long and OSGB buttons, [image: image19.bmp] [image: image20.bmp], are used to select the format for the coordinates when data are saved to a TomTom ASCII file or Excel spreadsheet.

The Point, Route and Track buttons, [image: image21.bmp] [image: image22.bmp] [image: image23.bmp], are used to specify the type of data being read into the program memory or output to file. The data type can be changed after a file has been read. This could be used to convert, say, a list of waypoints (POI) to a route.

The Track filter item in the Options menu can be used to reduce the number of points transferred from a track file into the program internal memory.

 Latitude and Longitude values

 When entering latitude and longitude values in TomTom ASC files and AutoRoute CSV files the values may be specified either as degrees and fractions of degrees, or in degrees, minutes and seconds. Both colons and single-quote/double-quote notation may be used for minutes and seconds. So, all the following values are accepted. 

53.5

53.5000

53'30"00

53'30

53:30:0

In output files the latitude and longitude values are written as decimal degrees.

OSGB references

 When entering OSGB36 references in TomTom ASC files, AutoRoute CSV files and Excel spreadsheets the value should be specified using the GB Ordnance Survey National Grid reference convention. The OS reference consists of a two-letter prefix followed by eastings and northings expressed as integers. The case of the prefix letters may be mixed. The total number of digits in eastings and northings combined must be even, with the same number of digits in the easting and northing. So, all of the following values are accepted.

SU 84 46

SU 840 460

SU 84000 46000

su840460

Symbols

 POIConverter when changing formats uses the mapping shown in the following table. Any other symbols will be mapped to a Waypoint (symbol number 0). NB. Symbol numbers cannot be passed to AutoRoute by any of the POIConverter file formats. The Memory-Map and OziExplorer symbol numbering is the same as that for MapSource.

	Map Source Number
	Description
	AutoRoute Number
	Symbol
	Maptech Number
	Description

	0
	Waypoint
	16
	[image: image24.png]



	37
	Dot

	1
	Residence
	77
	[image: image25.png]



	118
	House

	2
	Gas Station
	142
	[image: image26.png]



	145
	Fuel

	3
	Car
	82
	[image: image27.png]



	112
	Car

	4
	Fishing Area
	108
	[image: image28.png]



	130
	Fish

	5
	Boat Ramp
	154
	[image: image29.png]



	121
	Boat

	6
	Marina
	186
	[image: image30.png]



	37
	

	7
	Shipwreck
	56
	[image: image31.png]



	37
	

	8
	Exit
	129
	[image: image32.png]



	37
	

	9
	Skull and Crossbones
	176
	[image: image33.png]



	22
	Skull

	10
	Flag
	63
	[image: image34.png]



	23
	Flag

	11
	Campground
	153
	[image: image35.png]



	111
	Camp

	12
	Circle with X
	113
	[image: image36.png]



	37
	

	13
	Hunting Area
	157
	[image: image37.png]



	129
	Deer

	14
	Medical Facility
	119
	[image: image38.png]



	138
	First Aid

	15
	TracBack Point
	162
	[image: image39.png]



	37
	


TomTom ASCII data

 An extended form of the TomTom ASCII file (*.asc) format can be read and written by this program. The position of a POI can be given either as a pair of values giving its longitude and latitude or as GB Ordnance Survey National Grid reference (OSGB36). Optionally, a description field can be given after the name text but the text will not be used when creating overlay files (*.ov2). NB The longitude value must precede the latitude value.

The extended format is as follows

Longitude, LatitudeLonglatPair, "Name", "Description"

OSGB referenceOsgbReferences, "Name", "Description"

any line starting with a semi-colon will be treated as a comment and it will be ignored when the file is read.

The mapping of the data fields is as follows

	Internal
	TomTom ASCII

	Latitude
	Latitude

	Longitude
	Longitude

	Date 
	

	Time 
	

	Altitude 
	

	Name
	

	Description
	Name

	Comment
	Description*

	Proximity 
	

	Symbol
	

	Symbol text
	"Waypoint"

	Route/Track name
	"Point data"

	Colour
	


* Optional

The Options menu item TomTom, or the button [image: image40.bmp],can be used to create a default style for the POI names when they are output.

TomTom overlays

 Any TomTom overlay files, from Navigator and Route Planner, that are to be converted to another format must be transferred from the Pocket PC to the Windows PC running this program. Direct access of the Pocket PC files is not supported. 

When saving as a Route Planner overlay it is necessary to specify the file extension (.ovr) as the default file extension is .ov2

The mapping of data fields is as follows

	Internal
	TomTom overlay

	Latitude
	Latitude

	Longitude
	Longitude

	Date 
	File date

	Time 
	File time

	Altitude 
	

	Name
	

	Description
	Name

	Comment
	

	Proximity 
	

	Symbol
	

	Symbol text
	"Waypoint"

	Route/Track name
	"Point data"

	Colour
	


Note: Route Planner overlays store the position coordinates in 10,000ths of a degree. Therefore, any coordinates read from an ovr file will show only 4 significant figures after the decimal point when output to text files.

The Options menu item TomTom, or the button [image: image41.bmp],can be used to create a default style for the POI names when they are output.
TomTom Navigator 3 Itinerary Files

 Itinerary files can be opened and saved using tap-and-hold in the Itinerary screen on the PocketPC. When creating a route using MapSource make sure that Edit | Preferences... | Routing is set to Use Direct Routes otherwise all of the intermediate turns will be output. TomTom Navigator does not require these intermediate details.

The locations of route points transferred from another mapping program may not be on a road in the TomTom map. Use tap-and-hold on an itinerary entry on the TomTom Navigator Itinerary screen and then select More... and Show on map to see its location. A better point can be placed using tap-and-hold on the map and Add to itinerary. The original misplaced entry can be removed using tap-and-hold on it and selecting Delete | Yes on the pop-up menu.

The mapping of the data fields is as follows

	Internal
	TTN3 Itinerary

	Latitude 
	Latitude

	Longitude
	Longitude

	Date
	File date

	Time
	File time

	Altitude
	

	Name
	Entry type*

	Description
	Name

	Comment
	

	Proximity
	

	Symbol
	

	Symbol description
	"Dot"

	Route/Track name
	File name

	Colour
	


* On input set to DISABLED (0), DRIVEBY (1), DESTINATION (3) and DEPARTURE (4)

TomTom Navigator Log files

 Log files (*.pgl) can be recorded by TomTom Navigator to show the track followed when navigating. Log files that contain NMEA formatted records can be imported into POIConverter. The Track filter OptionOptions can be used to reduce the number of track points read from the file.

The time, position coordinates, number of satellites used in fixing the position and altitude are extracted from $GPGGA records. The satellite numbers from $GPGSA records and the true course and speed over ground from $GPVTG records.

The mapping of the data fields is as follows

	Internal
	TomTom Logs

	Latitude 
	Latitude

	Longitude
	Longitude

	Date
	File date

	Time
	Time

	Altitude
	Altitude

	Name
	

	Description
	Speed (mph/kph)*, True course*, Altitude (m)

	Comment
	Satellite numbers

	Proximity
	

	Symbol
	

	Symbol description
	"Dot"

	Route/Track name
	File name

	Colour
	


* If $GPVTG records are present

Maptech Marks

 Maptech Marks files (*.mxf) can be imported into and exported from Memory-Map Navigator.

Use the menu sequence Overlay | Import... and then select the appropriate file type in the Open dialog box to import a Marks file.

Use the menu sequence Overlay | Export Visible... and then select the Maptech Terrain Mark file type to export the visible Memory-Map Waypoints.

Memory-Map Navigator can be used to import/export waypoints to various handheld GPS systems, eg Garmin eTrex.

The mapping of the data fields is as follows

	Internal
	Maptech Marks

	Latitude
	Latitude

	Longitude
	Longitude

	Date
	File date

	Time
	File time

	Altitude
	

	Name
	Short name

	Description
	Full name

	Comment
	Comment

	Proximity
	

	Symbol
	Symbol numberSymbols

	Symbol text
	Dot, House etc

	Route/Track name
	"Point data"

	Colour
	Colour value


The Options menu item Maptech, or the button [image: image42.bmp], can be used to select a default symbol and short name prefix.

Maptech Route Files

 Maptech Route files (*.rxf) can be imported into and exported from Memory-Map Navigator.

Use the menu sequence Overlay | Import... and then select the appropriate file type in the Open dialog box to import a Route file.

Use the menu sequence Overlay | Export Visible... and then select the Maptech Terrain Route file type to export the visible Memory-Map Routes.

The mapping of the data fields is as follows

	Internal
	Maptech Routes

	Latitude
	Latitude

	Longitude
	Longitude

	Date
	File date

	Time
	File time

	Altitude
	

	Name
	Short name

	Description
	Full name

	Comment
	Comment

	Proximity
	

	Symbol
	Waypoint symbol number

	Symbol text
	Dot etc

	Route/Track name
	Route name

	Colour
	Waypoint colour value


Maptech Track Files

 Maptech Track files (*.txf) can be imported into and exported from Memory-Map Navigator. The Track filter OptionOptions can be used to reduce the number of track points read from the file.

Use the menu sequence Overlay | Import... and then select the appropriate file type in the Open dialog box to import a Track file.

Use the menu sequence Overlay | Export Visible... and then select the Maptech Terrain Track file type to export the visible Memory-Map Tracks.

The mapping of the data fields is as follows

	Internal
	Maptech Tracks

	Latitude
	Latitude

	Longitude
	Longitude

	Date
	File date

	Time
	File time

	Altitude
	

	Name
	

	Description
	

	Comment
	

	Proximity
	

	Symbol
	 

	Symbol text
	"Dot"

	Route/Track name
	Track name

	Colour
	Track colour value


Memory-Map CSV Waypoint Files

Memory-Map CSV files (*.csv) can be imported into and exported from Memory-Map Navigator.

Use the menu sequence Overlay | Import... and then select the CSV file type in the Open dialog box.

Use the menu sequence Overlay | Export Visible... and then select the CSV file type to export data for use with POIConverter.

Memory-Map Navigator can be used to import/export waypoints to various handheld GPS systems, eg Garmin eTrex.

The first record in the file is used to distinguish Memory-Map CSV files from AutoRoute Pushpin files.

The mapping of the data fields is as follows

	Internal
	Memory-Map CSV Waypoints

	Latitude
	Latitude

	Longitude
	Longitude

	Date
	

	Time
	

	Altitude
	

	Name
	Unique

	Description
	Name

	Comment
	Comment

	Proximity
	Radius

	Symbol
	Symbol number

	Symbol text
	Dot, House etc

	Route/Track name
	Category*

	Colour
	


* The output file name will be written to the Category field when creating a CSV file.

Garmin Waypoint Files

 Garmin PCX5 formatted Waypoint files can be imported into MapSource but not exported from it. Waypoint data can be exported as a Tab delimited text file (.txt) that can be read by this program for conversion to other formats. MapSource v 6.5 supports the import and export of files in GPS eXchange format, but it does not support the proximity field.

To import the PCX5 waypoint data into MapSource select the Import... item in the MapSource File menu and select the waypoint file (*.wpt) to be used. A dialog box giving three options relating to symbol selection will appear - select the second of these (16 symbols) and click the OK button. The imported data will always be sent to a new map so if any user data already exists in the open map then you will be prompted to save it.

The mapping of the data fields is as follows

	Internal
	Garmin PCX5 Waypoints

	Latitude
	Latitude*

	Longitude
	Longitude*

	Date
	Date

	Time
	Time

	Altitude
	Alt

	Name
	Idnt

	Description
	Description

	Comment
	

	Proximity
	Proximity

	Symbol
	Symbol numberSymbols (0 - 15)

	Symbol text
	Waypoint, Residence etc

	Route/Track name
	"Point data"

	Colour
	


* Degree minute or decimal degree input as defined in Header (H) record. Output is in decimal degrees.

The waypoint names sent to the output file are made unique by adding a sequence number in the final character positions of the 6 character identifier. The Options menu item Garmin, or the button [image: image43.bmp], can be used to select default values for the Waypoint IDNT prefix, Symbol, Altitude and Proximity. The Waypoint IDNT prefix value and a sequence number will be used to generate a waypoint IDNT for the output records if the Replace existing waypoint IDNT box is ticked.

Garmin Route Files

 Garmin PCX5 formatted Route files can be imported into MapSource but not exported from it. MapSource v 6.5 supports the import and export of files in GPS eXchange format.
To import the PCX5 route data into MapSource select the Import... item in the MapSource File menu and select the waypoint file (*.rte) to be used. A dialog box giving three options relating to symbol selection will appear - select the second of these (16 symbols) and click the OK button. The imported data will always be sent to a new map so if any user data already exists in the open map then you will be prompted to save it.

The mapping of the data fields is as follows

	Internal
	Garmin PCX5 Routes

	Latitude
	Latitude*

	Longitude
	Longitude*

	Date
	Date

	Time
	Time

	Altitude
	Altitude

	Name
	Idnt

	Description
	Description

	Comment
	

	Proximity
	Proximity

	Symbol
	Symbol (0 - 15)

	Symbol description
	Waypoint, Residence etc

	Route/Track name
	Route name

	Colour
	


* Degree minute or decimal degree input as defined in Header (H) record. Output is in decimal degrees.

Garmin Track Files

 Garmin PCX5 formatted Track files can be imported into MapSource but not exported from it. The Track filter OptionOptions can be used to reduce the number of points read from the file. MapSource v 6.5 supports the import and export of files in GPS eXchange format.
To import the PCX5 track data into MapSource select the Import... item in the MapSource File menu and select the waypoint file (*.trk) to be used. A dialog box giving three options relating to symbol selection will appear - select the second of these (16 symbols) and click the OK button. The imported data will always be sent to a new map so if any user data already exists in the open map then you will be prompted to save it.

The mapping of the data fields is as follows

	Internal
	Garmin PCX5 Tracks

	Latitude
	Latitude*

	Longitude
	Longitude*

	Date
	Date

	Time
	Time

	Altitude
	Altitude

	Name
	

	Description
	

	Comment
	

	Proximity
	

	Symbol
	

	Symbol description
	"Dot"

	Route/Track name
	"Track"nn

	Colour
	


* Degree minute or decimal degree input as defined in Header (H) record. Output is in decimal degrees.

GPS eXchange Files

 GPX (the GPS eXchange Format) is a light-weight XML data format for the interchange of GPS data (waypoints, routes, and tracks) between applications and web services on the Internet. Waypoint, route and track data from GPS eXchange files (*.gpx) can be read and written by POIConverter. The Track filter OptionOptions can be used to reduce the number of points transferred from a file.

The mapping of the data fields is as follows

	Internal
	GPS eXchange

	Latitude
	<lat>*

	Longitude
	<lon>*

	Date 
	<time>*

	Time 
	<time>*

	Altitude 
	<ele>*

	Name
	<name>*

	Description
	<desc>*

	Comment
	<cmt>*

	Proximity 
	

	Symbol
	

	Symbol text
	<sym>*

	Route/Track name
	"Point data"#, <name>+

	Colour
	


* from <wpt>, <rtept> or <trkpt>

+ from <rte> or <trk>

# for <wpt>

AutoRoute PushPins

 The POI data are transferred into AutoRoute using the Import Data... item on the File menu or the Import Data Wizard button. Select the TextFiles filter (*.txt;*.csv;*.tab;*.asc) and then the particular file that you want to import. The Wizard will then take you through the steps required to import the data. It is only necessary to use the Next and Finish buttons as all of the required field names are in the text file.

The default Pushpin icon can be changed using the Data Set item on the Format menu.  Select a Pushpin and use the Show Information item on the Format menu or press the F8 key to display the information.

The first record in the file is used to distinguish Memory-Map CSV files from AutoRoute Pushpin files. Subsequent records should contain data fields in one of the two following formats:

Longitude, Latitude, "Name", "Information"

OS Grid Reference, "Name", "Information"

The mapping of the data fields is as follows

	Internal
	AutoRoute PushPins

	Latitude
	Latitude

	Longitude
	Longitude

	Date
	

	Time 
	

	Altitude 
	

	Name
	

	Description 
	Name

	Comment
	Information*

	Proximity 
	

	Symbol
	

	Symbol text
	"Waypoint

	Route/Track name
	"Point data"

	Colour
	


* Optional

Microsoft Excel Files

 Waypoints, routes and tracks can be imported from and exported to Microsoft Excel spreadsheets (*.xls). The Excel data must be defined on a sheet with column headings exactly as below. Waypoint data must be on a sheet named Points, route data on Routes and track data on Tracks. More than one route or track can be defined on the same sheet. A new route or track will be assumed to have started when the entry in the "Route or Track name" column changes. The column names have been chosen to facilitate the import of data into AutoRoute.

The mapping of the data fields is as follows

	Internal
	Excel column heading

	Latitude, Longitude
	OS Grid Reference*

	Latitude 
	Latitude*+

	Longitude
	Longitude*+

	Date, Time
	Date and Time

	Altitude
	Altitude

	Name
	Name 2*

	Description
	Name*

	Comment
	Information

	Proximity
	Proximity

	Symbol
	

	Symbol description
	Symbol name

	Route/Track name
	Route or Track name

	Colour
	Colour name


* These fields are recognized by the AutoRoute Import Wizard.

+ The coordinates can be specified as an OSGB Reference, in which case these fields should be left blank. The values in these fields will be used in preference to the OSGB value if both are defined.

MapSource Files

 Waypoints, routes and tracks can be exported from MapSource as Tab delimited text files (.txt) and read by this program for conversion to other formats. Use Garmin PCX5 formatted data to import waypoints, routes and tracks into MapSource. The Track filter OptionOptions can be used to reduce the number of points read from the file.

If the Description field is blank then the Name field will be copied to it when the file is read.

The mapping of the data fields is as follows

	Internal
	MapSource

	Latitude
	Position

	Longitude
	Position

	Date 
	Date*

	Time 
	Time*

	Altitude 
	Altitude

	Name
	Name#+

	Description
	Description#+

	Comment
	

	Proximity 
	Proximity#+

	Symbol
	

	Symbol text
	"Waypoint"#

	Route/Track name
	"Point data"#, Route name+, Track name*

	Colour
	


# for waypoints

+ for routes

* for tracks

Microsoft Maps

 The PushPin and Route data contained within an AutoRoute map file (*.axe) a Streets and Trips map file (*.est), or a MapPoint map file (*.ptm) are extracted by running James Sherring's program st2gpx from within POIConverter. st2gpx creates a GPS eXchange formatted file (*.gpx) which is then read to extract either the PushPin or Route information. The intermediate GPX file, st2gpx.tmp, is not deleted afterwards if the program is running in debug mode.

The mapping of the data fields is as follows

	Internal
	AutoRoute Maps

	Latitude
	Latitude

	Longitude
	Longitude

	Date 
	

	Time 
	

	Altitude 
	

	Name
	

	Description
	Name

	Comment
	Information

	Proximity 
	

	Symbol
	

	Symbol text
	"Waypoint" or <sym>*, "Dot"#

	Route/Track name
	"Point data", File name#

	Colour
	 


* <sym> element from intermediate GPX file. AR2004

# for Routes

Microsoft Pocket Streets

 To export Pushpin information from Microsoft AutoRoute it is necessary to select an area of the map that contains the Pushpin data by 'dragging' an area using the Select tool. Do not click in the area to zoom in on the selected region. When the bounding box is visible on the map use the Export Maps for Pocket Streets...'item in the File menu and follow the instructions. This will create two files, a map file (.mps) and a Pushpin file (.psp). When the PushPin file is opened in POIConverter the locations and details (name and the attached notes) are extracted.

The coordinates transferred to the psp file are incorrect (by a small but variable amount) if the data are exported from versions of AutoRoute newer than AutuoRoute 2001.
Do not select too large an area of map as it will take a long time to export all of the street detail, and none of this is required for the Pushpin transfer. 

The mapping of the data fields is as follows

	Internal
	Pocket Streets

	Latitude
	Latitude

	Longitude
	Longitude

	Date 
	

	Time 
	

	Altitude 
	

	Name
	

	Description
	Name

	Comment
	Notes

	Proximity 
	

	Symbol 
	

	Symbol text
	"Waypoint"

	Route/Track name
	"Point data"

	Colour
	


OziExplorer Waypoint Files

OziExplorer waypoints defined in the WGS 84 datum can be input and output. The header record is examined to check that the data is in OziExplorer format as the WPT extension is also used for Garmin PCX5 waypoints.

The mapping of the data fields is as follows

	Internal
	 OziExplorer Waypoints

	Latitude
	 Latitude

	Longitude
	 Longitude

	Date
	 From TDateTime

	Time
	 From TDateTime

	Altitude
	 Alt

	Name
	 Name

	Description
	 Description

	Comment
	

	Proximity
	 Proximity

	Symbol
	 Symbol numberSymbols (0 - 15)

	Symbol text
	 Waypoint, Residence etc

	Route/Track name
	 "Point data"

	Colour
	


The waypoint names sent to the output file are made unique. The OptionsOptions menu item OziExplorer, or the button [image: image44.bmp], can be used to select default values for the Waypoint Symbol, Altitude and Proximity. 

OziExplorer Route Files

OziExplorer routes defined in the WGS 84 datum can be input and output. The header record is examined to check that the data is in OziExplorer format as the RTE extension is also used for Garmin PCX5 routes.

The mapping of the data fields is as follows

	Internal 
	 OziExplorer Routes

	Latitude 
	 Latitude

	Longitude 
	 Longitude

	Date 
	 From TDateTime

	Time 
	 From TDateTime

	Altitude 
	

	Name 
	 Name from W record

	Description 
	 Description from W record

	Comment 
	

	Proximity 
	

	Symbol 
	 Symbol numberSymbols (0 - 15)

	Symbol text 
	 Waypoint, Residence etc

	Route/Track name 
	Description from R record

	Colour 
	


Although all the waypoint details are stored with each route OziExplorer requires the waypoints to be loaded on the map before it will display the route. A waypoint file can be created from a route file within POIConverter. First, read the route file, then select the menu option Points or the [image: image45.bmp] button and finally, save the data.

OziExplorer Track Files

OziExplorer tracks defined in the WGS 84 datum can be input and output. The header record is examined to check that the data is in OziExplorer format.

The mapping of the data fields is as follows

	Internal
	 OziExplorer Tracks

	Latitude
	 Latitude

	Longitude 
	 Longitude

	Date 
	 From TDateTime

	Time 
	 From TDateTime

	Altitude 
	 Alt

	Name 
	

	Description 
	

	Comment 
	

	Proximity 
	

	Symbol 
	

	Symbol text 
	 "Dot"

	Route/Track name 
	 Description

	Colour 
	


On input Date and Time values are extracted from field 5 (TDateTime). The text versions in fields 6 and 7 of the input record are not used.

Destinator 3 Waypoint Files

The Comma Separated Value (CSV) records output for Destinator 3 have the following format

Name,POIConverter vx.xx,Longitude,Latitude

where POIConverter vx.xx is a text string and x.xx is the current version of the POIConverter program. The Destinator 3 documentation will give the procedure to be followed to import CSV data.

The mapping of the data fields is as follows

	Internal -
	 Destinator 3 waypoints

	Latitude -
	 Latitude

	Longitude -
	 Longitude

	Date -
	

	Time - 
	

	Altitude - 
	

	Name -
	

	Description - 
	 Name

	Comment -
	

	Proximity - 
	

	Symbol -
	

	Symbol text -
	

	Route/Track name -
	

	Colour -
	


Mapopolis Waypoint Files

The Mapopolis utility program GPXToMaplet is run from within POIConverter to convert the GPX data written to an intermediate file, having the same name as the *.mlp file but with an extension gpx, to create the maplet file (*.mlp).

The mapping of the internal data fields to the intermediate GPX file is as follows

	Internal -
	 Mapopolis GPX waypoint data

	Latitude -
	 Lat=

	Longitude -
	 Lon=

	Date -
	 <time>*

	Time - 
	 <time>*

	Altitude - 
	 <ele>

	Name -
	 <name>

	Description - 
	 <desc>

	Comment -
	 <cmt>

	Proximity - 
	

	Symbol -
	

	Symbol text -
	 <sym> default "Waypoint"

	Route/Track name -
	

	Colour -
	


* a single item formatted as yyyy-mm-ddThh:mm:ssZ, eg 2004-01-05T19:16:10Z

If POIConverter is run in Debug mode then the intermediate GPX file is left in the same folder as the output file. GPXToMaplet can then be run separately to identify any data problems.

Internal data structure

 The program uses a structure, with the following fields, to store the data read from the differently formatted input files. The fields used by the different file formats are shown below: -

	Field   
	 Associated file type

	Latitude
	asc, ov2, ovr, mxf, wpt', wpt", txt, csv', csv", [tab], axe, ptm, gpx, psp, rxf, txf, rte', rte", trk, xls, itn, pgl, plt

	Longitude
	asc, ov2, ovr, mxf, wpt', wpt", txt, csv', csv", [tab], axe, ptm, gpx, psp, rxf, txf, rte', rte", trk, xls, itn, pgl, plt

	Date
	wpt', wpt", txt, gpx, rte', rte", trk, xls, pgl, plt

	Time
	wpt', wpt", txt, gpx, rte', rte", trk, xls, pgl, plt

	Altitude (m)
	wpt', wpt", txt, gpx, rte', trk, xls, pgl, plt

	Name
	mxf, wpt', wpt", txt, csv", gpx, rxf, rte', rte", xls, itn

	Description
	asc, ov2, ovr, mxf, wpt', wpt", txt, csv', csv", [tab], axe, ptm, gpx, psp, rxf, rte', rte", xls, itn, pgl

	Comment
	asc, mxf, csv', csv", [tab], axe, ptm, gpx, psp, rxf, xls, pgl

	Proximity (m)
	wpt', wpt", txt, csv", rte', xls

	Symbol
	wpt', wpt", txt, csv", rte', xls

	Symbol text
	gpx, xls

	Route/Track name
	txt, csv", gpx, rxf, txf, rte', rte",xls, pgl, plt

	Colour
	mxf, rxf, txf, xls


asc - TomTom ASCII format (extended)

ov2 - TomTom Navigator overlay format

ovr - TomTom Route Planner overlay format

itn - TomTom Navigator 3 Itinerary format (Route)

pgl - TomTom Navigator Log (Track) NMEA format

wpt' - Garmin Waypoint format (PCX5)

rte - Garmin Route format (PCX5)

trk - Garmin Track format (PCX5)

txt - Garmin MapSource export format (Waypoints, Routes, Tracks)

csv' - AutoRoute Pushpin import format

tab - AutoRoute Pushpin (Continental numbers) import format

axe - AutoRoute Map format (import)

ptm – MapPoint Map format (import)

psp - Pocket Streets Pushpin format (import)

mxf - Maptech Marks format

rxf - Maptech Route format

txf - Maptech Track format

csv" - Memory-Map CSV format (Waypoints)

gpx - GPS eXchange format (Waypoints, Routes, Tracks)

xls - Excel format (Waypoints, Routes, Tracks)

wpt" - OziExplorer Waypoint format

rte" - OziExplorer route format

plt - OziExplorer track format

[] output only

History

3.14 12/08/2005

GPS eXchange Options menu item and button added to allow the default waypoint name style to be altered. Microsoft Streets and Trips map file (*.est) support added. Longitude error corrected for locations in the USA read from a Pocket Streets file (*.psp).

3.13 12/07/2005

Waypoint output in Mapopolis Maplet format added. The error that prevented the default bitmap file, stored in the program folder, from being used for newly created TomTom overlays was corrected.

3.12 30/05/2005

Waypoint output in Destinator 3 CSV format added.

3.11 22/4/2005

Storage increased to 40,000 points and MapPoint name added to the input file filter.

3.10 21/1/2005

Waypoints, Routes and Tracks in OziExplorer format (WGS 84 datum) can be input and output. The TomTom utility MakeOV2 is run to create TomTom overlay files as the previous internal code does not create Type 1 (Skipper) records. TomTom options added for POI name mapping, length and blank name prefix. GPX input routine modified to cope with large amounts of embedded text that should be ignored by POIConverter.

3.09 17/9/2004

Symbol mapping added for Memory-Map CSV data. Various bug fixes.

3.08 31/8/2004

Unique name algorithm changed to use only alpha characters.

3.07 20/8/2004

Waypoints stored in Memory-Map CSV files can be input and output. The path of the last used input folder is saved in the Windows Registry and it is used as the default folder when the program is restarted.

3.06 8/7/2004

The waypoint identifiers output to the Garmin WPT and RTE files are made unique. Storage limit check added in all read routines. The Garmin Option to replace the waypoint IDNT field on output now works correctly.  Both NMEA $GPRMC and $GPVTG records used to extract course and speed data from TomTom Navigator Log files (*.pgl).

3.05 12/6/2004

The worksheet name and column names are checked prior to importing data from an Excel file.

3.04 6/6/2004

Limit on the number of POI increased to 15000 and missing limit checks added in AutoRoute and GPX subroutines.

3.03 29/5/2004

qtXLS library updated to 24/5/04 version. Error caused by blank Date/Time field in MapSource txt file track data has been corrected.

3.02 7/5/2004

When converting AutoRoute Map files the ST2GPX output is sent to the file st2gpx.tmp and is left in the input file folder after the run. ST2GPX will not produce an output file if the path to the program contains spaces. As a work-around, POIConverter now installs to the folder C:\Richard_Davies\POIConverter.

 3.01 1/5/2004

Support for Excel spreadsheets reinstated but there are still some problems. Support added for TomTom Navigator 3 Itinerary files (*.itn) and NMEA Log files (*.pgl).

3.00 27/4/2004

Support for Excel spreadsheets disabled pending qtXLS library update. Identifier field deleted from internal structure. Garmin PCX5 coordinate output changed to decimal degrees. Decimal degree input support added.

2.02.1 20/4/2004

Support for Pocket Streets PushPin file (*.psp) input reinstated. ST2GPX updated to version 0.5.

2.01 30/3/04

Support for Pocket Streets PushPin file (*.psp) input removed. Comma separated value (*.csv) file input added.

2.00 21/3/04

Input and output of route and track data added for Maptech, Garmin PCX5 and GPX formatted data. Input of route and track data from MapSource text file added.

1.03 10/03/04

Pushpin names extracted from AutoRoute Map files, via the intermediate GPX files, passed to TomTom Navigator overlay Name field.

1.02 14/01/04

Pushpin data extracted from Microsoft AutoRoute Map files using James Sherring's st2gpx program. Reading and writing of GPX files supported. Garmin conversion uses the H IDNT record to determine field lengths on input.

1.01 07/07/03

Error in the transfer of Pocket Streets notes corrected.

TomTom Route Planner overlay (ovr) file support added.

1.00 23/06/03

Initial release.
